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1 Introduction 
This guide is a technical resource that enables users to complete the Wetland Ecosystem 
Services Protocol (WESP-BC) Desktop Assessment. Before beginning the Desktop 
Assessment, users should be familiar with the User Manual for WESP-BC and have 
completed the WESP-BC Field Assessment. 

The Desktop Assessment requires interpreting satellite imagery and provincial spatial 
datasets to answer 44 questions. While this guide references publicly available province-
wide datasets, users are encouraged to utilize higher-quality local data or superior 
imagery where available. Local knowledge and field notes should also be available while 
completing this assessment. 

All datasets mentioned are intended as reference resources; final responses should be 
based on the most suitable answer using professional judgment. Observations made 
during the field assessment including defined boundaries, land use observations, field 
notes, and interpretation of recent imagery must be prioritized over spatial datasets, 
which may be outdated or contain inaccuracies or not appropriate for the area of 
assessment. 

This guide provides step-by-step instructions to assist users when deciding between 
multiple options. It is designed with the following principles in mind: 

• Proportional Effort: In many cases, all analysis steps listed here will not be 
necessary. For most sites, answers will clearly fall into the lowest or highest 
categories, and exact calculations of area or percent cover may not be required 

• Oversight: The process encourages manual oversight of every question to mitigate 
issues arising from mapping inaccuracies or limited data 

• Optimization: Users are encouraged to pursue opportunities for automation, 
provided that the integrity of the "best available data" is maintained 

All final responses must be entered into the current WESP-BC Desktop Survey123 Form 
for each site. Once the desktop questions are submitted, the .csv outputs from both the 
Field and Desktop Assessments are used within the wespr tool to calculate the final 
function and benefit scores and ratings. 

Most desktop-based questions described in this manual require the use of GIS. A variety of 
different software can be used to complete this analysis. In this guide, examples of GIS 
processes are written for ArcGIS Pro 3.6, although equivalent tools commonly exist for 
alternative GIS software. Some of the foundational skills to use the software have been 
described in Appendix A. The GIS instructions included in this guide assume a basic 
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working knowledge of GIS and the ability to utilize tools for analysis and data preparation 
including: the creation of buffers, erasing features, clipping features, calculating 
geometries, summarizing statistics, selecting intersecting features, etc.   

In some cases, geospatial files used as input in the analysis may be outdated, and no 
longer reflect current conditions (for example, a new clearcut, fire, or adjacent 
development may have cleared adjacent land and could impact the corresponding 
questions regarding adjacent conditions). Higher-quality or more recent local datasets (for 
example, drone imagery, local mapping) should be used where available and may 
supersede province-wide datasets. Users are advised to use the highest-quality data and 
professional judgement to answer these questions.  

Data preparation  
To make the Desktop Assessment as efficient as possible, some preparatory processing 
should be completed first. To support repeatability of the results for peer review, auditing 
or other quality assurance purposes, the datasets created for the Desktop Assessment 
should be retained and accompany the other data collected and packaged with WESP-BC 
results. To simplify file names, it is recommended to save all layers within one folder with 
the suggested standardized naming scheme provided in quotations in Table 1.1 under the 
column Data Layer Name. 

Prior to answering the Desktop Assessment Survey123 questions it is recommended to 
digitize features (polygons and polylines) collected specifically for your site and ideally 
have already digitized any field confirmed features of targeted areas ready. Field 
observations may require you to modify: your Assessment Area (AA), Contributing Area 
(CA), streams, and open water features. A full list of digitized features to prepare is 
recommended to facilitate your analysis in Table 1.1. Note that the buffers recommended 
may be useful to determine presence or absence of specific occurrences (for example, 
roads or lakes) within a certain distance of the AA. In some cases, buffers are used to clip 
other datasets to calculate areas or determine percent coverage.  
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Table 1.1 Recommended Features to Digitize and Naming Conventions for Desktop 
Assessment   

Data Layer Name Description Relevant 
Question(s) 

AA* 
AA, based on AA guidance in the WESP-BC 
User Manual  
Attributes including area in Hectares (Ha) 

All questions 

wetland_entire Entire estimated area of the wetlands if the 
AA is only a portion of the AA.  OF11 

AA_OpenWater* Open water observed in the field  

Streams_field_verified * Streams mapped based on recent imagery or 
field observations  

Buffer_100m 100 m buffer including the AA  OF21, OF36 

Buffer_100m_excluding_AA 100 m buffer around the AA with excluding 
the wetland OF30 

Buffer_1km 1 km buffer polygon around the AA OF34 
Buffer_2km 2 km buffer polygon around the AA OF18, 19, 37 

Buffer_2km_excluding_AA 2 km buffer around the AA with the AA 
polygon excluded OF 31, 32, 33 

Buffer_5km 5 km buffer polygon around the AA OF 34 
Buffer_10km 10 km buffer polygon around the AA OF 4 

Lakes_clipped_2km** All mapped lakes clipped to a 2km buffer 
Hectares field calculated 

 
OF 18, 19 

Wetlands_clipped_2km** 
Portions of mapped wetlands inside the 2 km 
buffer of the AA 
Hectares field calculated 

OF 19 

Wetland_100m_Buffer** Wetlands within 100 m buffer OF 12 

CA_polygon* Manually digitized polygon representing the 
full contributing area OF 11 

CA_excluding_AA Contributing area polygon where AA is 
removed OF 11 

Disturbed_WAU** Disturbance within the WAU boundary OF 41 

WAU** Assessment Watersheds Unit (WAU) that 
wetland falls within 

OF 12, 41, 42, 
43 

Forests_within2km** Forests within 2 km buffer OF 33 
AA_Landcover** Land cover features clipped to the AA OF 35 
Landcover_1km** Land cover within 1 km buffer OF 34 
Landcover_5km** Land cover within 1 km buffer OF 34 
Landcover_AA_100m** Landcover within 100 m including AA OF 36 

Mature_OldGrowth_within2km** Mature or old growth forests within 2 km 
buffer OF 33 

Roads_WAU** Roads with the WAU boundary OF 42 

HumanDisturbance_2km** Human disturbance layer clipped to within 2 
km OF 32 
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Accessing publicly available datasets  
Many questions in this assessment will require review of publicly available datasets. 
Table 1.2 provides a list of recommended datasets to consider as part of your analysis and 
are referenced along with the guidance for each office question in Section 2. Where 
available, both links to datasets and permalinks underneath for sources are provided that 
have provincial wide distribution in B.C. These datasets are suggested as a starting point 
but may be replaced by higher-quality locally available data. Most of these datasets can be 
viewed on iMap or downloaded from the BC Data Catalogue.  
 
For user convenience, a package is available on GitHub1 that contains a subset of layers 
that can be obtained using the package. This package can be run by a beginner in RStudio 
and only requires the AA to be input as a .gpkg file. The package then identifies the 
Assessment Watersheds Unit and a 10 km buffer as the Area of Interest (AOI), for which all 
layers available are downloaded to a single folder. Other options for viewing and 
downloading the required spatial datasets are described in Appendix A.  

 
1 https://bcwf-wetlands.github.io/wespr/articles/prepare_spatial_data.html 

Data Layer Name Description Relevant 
Question(s) 

AllRoads_100m** All roads within 100 m buffer of the AA OF 30 

AA_DesignatedOverlap** Portion of the AA intersecting designated 
conservation/ecological lands OF 21 

*- Digitization of this feature to incorporate observations from field 
** - These layers will require supplementary data sets. See Table 1.2. for recommended data 
sources. 

https://bcwf-wetlands.github.io/wespr/articles/prepare_spatial_data.html
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Table 1.2. Recommended datasets for Desktop Assessment 

Dataset name Question 
relevance  

Not 
included in 
preparing 
spatial data 
package 

Permalink Reference 

Aerial Imagery for the site and surrounding 
area All X - Select most appropriate for the area 

Land Cover Mapping  OF 34, 35, 36, 37 X - Select most appropriate for the area 

BC Wildfire Fire Perimeters – Historical  OF 15 - https://catalogue.data.gov.bc.ca/dataset/22c7cb44-1463-
48f7-8e47-88857f207702 Government of British Columbia 2025b 

BC Cumulative Effects Framework - Human 
Disturbance  

OF 31, 32, 41 - https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-
4aeb-ac8b-7b10e84b046c Government of British Columbia 2023a 

BC Cumulative Effects Framework – 
Integrated Roads  OF 2, 9, 30, 42 - https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-

4503-8cd7-dcf0bdf2ae99 Government of British Columbia 2025a 

BC Historical Fish Distribution – Points 
(50,000) 

OF 20 - https://catalogue.data.gov.bc.ca/dataset/3b723ef2-abd4-
4722-abea-9a51258eae15 Government of British Columbia 2006 

Conservation Lands  OF 21, 22 - https://catalogue.data.gov.bc.ca/dataset/68327529-c0d5-
4fcb-b84e-f8d98a7f8612 Government of British Columbia 2025c 

Critical Habitat for Federally-Listed Species 
at Risk - Posted 

OF 21 - https://catalogue.data.gov.bc.ca/dataset/076b8c98-a3f1-
429b-9dae-03faed0c6aef Government of British Columbia  2024a 

Designated Lands (GitHub File) OF 21, 22 - https://github.com/bcgov/designatedlands/releases/downl
oad/v0.1.0/designatedlands.gpkg.zip - 

Digital Road Atlas (DRA) – Master Partially – 
Attributed Roads 

OF 2 (if 
applicable), 12, 
30, 31, 42 

- https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-
4548-b837-f9060d94743e Government of British Columbia 2025d 

Ecoprovinces - Ecoregion Ecosystem 
Classification of British Columbia 

OF 44 - https://catalogue.data.gov.bc.ca/dataset/51832f47-efdf-
4956-837a-45fc2c9032dd Government of British Columbia 2004 

Freshwater Atlas – Lakes OF 3, 18, 19 - https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-
4de1-a2d4-b8b6650fb1f6  Government of British Columbia 2008b 

Freshwater Atlas – Rivers OF 6, 9 - https://catalogue.data.gov.bc.ca/dataset/f7dac054-efbf-
402f-ab62-6fc4b32a619e Government of British Columbia 2025e 

https://catalogue.data.gov.bc.ca/dataset/22c7cb44-1463-48f7-8e47-88857f207702
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
https://catalogue.data.gov.bc.ca/dataset/3b723ef2-abd4-4722-abea-9a51258eae15
https://catalogue.data.gov.bc.ca/dataset/3b723ef2-abd4-4722-abea-9a51258eae15
https://catalogue.data.gov.bc.ca/dataset/conservation-lands
https://catalogue.data.gov.bc.ca/dataset/critical-habitat-for-federally-listed-species-at-risk-posted-
https://catalogue.data.gov.bc.ca/dataset/critical-habitat-for-federally-listed-species-at-risk-posted-
https://github.com/bcgov/designatedlands/releases/download/v0.1.0/designatedlands.gpkg.zip
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/51832f47-efdf-4956-837a-45fc2c9032dd
https://catalogue.data.gov.bc.ca/dataset/51832f47-efdf-4956-837a-45fc2c9032dd
https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
https://catalogue.data.gov.bc.ca/dataset/f7dac054-efbf-402f-ab62-6fc4b32a619e
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Dataset name Question 
relevance  

Not 
included in 
preparing 
spatial data 
package 

Permalink Reference 

Freshwater Atlas – Stream Directions OF 6, 8, 9, 10, 11 - https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-
41d0-b762-c53e3468ff3f Government of British Columbia 2023b 

Freshwater Atlas – Glaciers OF 8 - https://catalogue.data.gov.bc.ca/dataset/8f2aee65-9f4c-
4f72-b54c-0937dbf3e6f7 Government of British Columbia 2008a 

Freshwater Atlas – Stream Network OF 6, 8, 9, 10, 11 - https://catalogue.data.gov.bc.ca/dataset/92344413-8035-
4c08-b996-65a9b3f62fca Government of British Columbia 2024b 

Freshwater Atlas – Assessment Watersheds OF 5, 6, 9, 12 - https://catalogue.data.gov.bc.ca/dataset/51f20b1a-ab75-
42de-809d-bf415a0f9c62 Government of British Columbia 2008c 

Freshwater Atlas – Watershed Boundaries OF 11 - https://catalogue.data.gov.bc.ca/dataset/ab758580-809d-
4e11-bb2c-df02ac5465c9  Government of British Columbia 2025f 

Freshwater Atlas – Wetlands  OF 19, 43 - https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-
4770-9629-641d74bd1cc6 Government of British Columbia 2025g 

Geology Faults  OF 17 - https://catalogue.data.gov.bc.ca/dataset/c94e0c13-5385-
49c1-9922-822e10135fc6 Government of British Columbia 2018 

Municipalities - Legally Defined 
Administrative Areas of BC  

OF 1 - https://catalogue.data.gov.bc.ca/dataset/e3c3c580-996a-
4668-8bc5-6aa7c7dc4932 Government of British Columbia 2016 

NGO Conservation Areas – Fee Simple  OF 22 - https://catalogue.data.gov.bc.ca/dataset/a306e21b-58d6-
4b71-bac7-f3b1c8a4c779 Government of British Columbia 2024c 

Reconnaissance Karst Potential Mapping  OF 16 - https://catalogue.data.gov.bc.ca/dataset/395568e1-d233-
4217-9732-7afadb6f4265 Government of British Columbia 2002 

Species and Ecosystems at Risk - Publicly 
Available Occurrences - CDC 

OF 21, 22, 24 - https://catalogue.data.gov.bc.ca/dataset/0e035e55-f257-
458f-9a96-80c01c69d389 Government of British Columbia 2025i 

TANTALIS – Wildlife Management Areas OF 21, 22, 24 - https://catalogue.data.gov.bc.ca/dataset/f3ece977-aa7f-
4cb2-b7d0-de64155f6c83 Government of British Columbia 2025k 

TANTALIS – Conservancy Areas OF 21, 22 - https://catalogue.data.gov.bc.ca/dataset/550b3133-2004-
468f-ba1f-b95d0e281e78 Government of British Columbia 2025j 

Ungulate Winter Range – Approved OF 21 - https://catalogue.data.gov.bc.ca/dataset/712bd887-7763-
4ed3-be46-cdaca5640cc1 Government of British Columbia 2025l 

https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/8f2aee65-9f4c-4f72-b54c-0937dbf3e6f7
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/freshwater-atlas-assessment-watersheds
https://catalogue.data.gov.bc.ca/dataset/ab758580-809d-4e11-bb2c-df02ac5465c9
https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
https://catalogue.data.gov.bc.ca/dataset/c94e0c13-5385-49c1-9922-822e10135fc6
https://catalogue.data.gov.bc.ca/dataset/e3c3c580-996a-4668-8bc5-6aa7c7dc4932
https://catalogue.data.gov.bc.ca/dataset/e3c3c580-996a-4668-8bc5-6aa7c7dc4932
https://catalogue.data.gov.bc.ca/dataset/a306e21b-58d6-4b71-bac7-f3b1c8a4c779
https://catalogue.data.gov.bc.ca/dataset/395568e1-d233-4217-9732-7afadb6f4265
https://catalogue.data.gov.bc.ca/dataset/species-and-ecosystems-at-risk-publicly-available-occurrences-cdc
https://catalogue.data.gov.bc.ca/dataset/species-and-ecosystems-at-risk-publicly-available-occurrences-cdc
https://catalogue.data.gov.bc.ca/dataset/550b3133-2004-468f-ba1f-b95d0e281e78
https://catalogue.data.gov.bc.ca/dataset/712bd887-7763-4ed3-be46-cdaca5640cc1
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Dataset name Question 
relevance  

Not 
included in 
preparing 
spatial data 
package 

Permalink Reference 

VRI – Forest Vegetation Composite 
Polygons   

OF 28, 29, 38, 39, 
40 

X https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-
44ad-a11f-794feed39f40 

Government of British Columbia 2024d 

VRI –  Relational Data Dictionary X 

https://www2.gov.bc.ca/assets/gov/farming-natural-
resources-and-industry/forestry/stewardship/forest-
analysis-inventory/data-
management/standards/vegcomp_poly_rank1_data_diction
aryv5_2019.pdf 

Government of British Columbia 2019 

Old Growth Technical Advisory Panel (TAP) – 
Old Forests 

OF 33 X https://catalogue.data.gov.bc.ca/dataset/6f08c9d8-d6c0-
4f08-ac64-54585c92ccb0 Government of British Columbia 2026a 

Wildlife Species Inventory – Incidental 
Observations –Publicly Available 

OF 24 - https://catalogue.data.gov.bc.ca/dataset/7d5a14c4-3b6e-
4c15-980b-68ee68796dbe Government of British Columbia 2025o 

Wildlife Species Inventory – Survey 
Observations - Publicly Available 

OF 24 - https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-
4e9f-a4b5-27e123972816 

Government of British Columbia 2025n 

Wildlife Species Inventory – Telemetry 
Points – Publicly Available  

OF 24 - https://catalogue.data.gov.bc.ca/dataset/6d48657f-ab33-
43c5-ad40-09bd56140845 Government of British Columbia 2025p 

Wildlife Habitat Features – Incidental 
Observations – Publicly Available  

OF 24 - https://catalogue.data.gov.bc.ca/dataset/50dc6ba5-8883-
4bfc-b3aa-b420b190b45b Government of British Columbia 2025m 

Wildlife Habitat Features – Survey 
Observations – Publicly Available  

OF 24 - https://catalogue.data.gov.bc.ca/dataset/884c20fa-17c1-
491a-b5cb-993be5dff8d3 Government of British Columbia 2025n 

Secured Species at Risk Observations from 
Conservation Data Center (data request 
required) 

OF 24 - https://www2.gov.bc.ca/gov/content?id=302E3F5E951C400
58683EA767135BA7B Government of British Columbia 2026b 

https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://www2.gov.bc.ca/assets/gov/farming-natural-resources-and-industry/forestry/stewardship/forest-analysis-inventory/data-management/standards/vegcomp_poly_rank1_data_dictionaryv5_2019.pdf
https://www2.gov.bc.ca/assets/gov/farming-natural-resources-and-industry/forestry/stewardship/forest-analysis-inventory/data-management/standards/vegcomp_poly_rank1_data_dictionaryv5_2019.pdf
https://www2.gov.bc.ca/assets/gov/farming-natural-resources-and-industry/forestry/stewardship/forest-analysis-inventory/data-management/standards/vegcomp_poly_rank1_data_dictionaryv5_2019.pdf
https://www2.gov.bc.ca/assets/gov/farming-natural-resources-and-industry/forestry/stewardship/forest-analysis-inventory/data-management/standards/vegcomp_poly_rank1_data_dictionaryv5_2019.pdf
https://www2.gov.bc.ca/assets/gov/farming-natural-resources-and-industry/forestry/stewardship/forest-analysis-inventory/data-management/standards/vegcomp_poly_rank1_data_dictionaryv5_2019.pdf
https://www2.gov.bc.ca/assets/gov/farming-natural-resources-and-industry/forestry/stewardship/forest-analysis-inventory/data-management/standards/vegcomp_poly_rank1_data_dictionaryv5_2019.pdf
https://catalogue.data.gov.bc.ca/dataset/6f08c9d8-d6c0-4f08-ac64-54585c92ccb0
https://catalogue.data.gov.bc.ca/dataset/6f08c9d8-d6c0-4f08-ac64-54585c92ccb0
https://catalogue.data.gov.bc.ca/dataset/7d5a14c4-3b6e-4c15-980b-68ee68796dbe
https://catalogue.data.gov.bc.ca/dataset/7d5a14c4-3b6e-4c15-980b-68ee68796dbe
https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-4e9f-a4b5-27e123972816
https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-4e9f-a4b5-27e123972816
https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-4e9f-a4b5-27e123972816
https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-4e9f-a4b5-27e123972816
https://catalogue.data.gov.bc.ca/dataset/6d48657f-ab33-43c5-ad40-09bd56140845
https://catalogue.data.gov.bc.ca/dataset/6d48657f-ab33-43c5-ad40-09bd56140845
https://catalogue.data.gov.bc.ca/dataset/50dc6ba5-8883-4bfc-b3aa-b420b190b45b
https://catalogue.data.gov.bc.ca/dataset/50dc6ba5-8883-4bfc-b3aa-b420b190b45b
https://catalogue.data.gov.bc.ca/dataset/884c20fa-17c1-491a-b5cb-993be5dff8d3
https://catalogue.data.gov.bc.ca/dataset/884c20fa-17c1-491a-b5cb-993be5dff8d3
https://www2.gov.bc.ca/gov/content?id=302E3F5E951C40058683EA767135BA7B
https://www2.gov.bc.ca/gov/content?id=302E3F5E951C40058683EA767135BA7B
https://www2.gov.bc.ca/gov/content?id=302E3F5E951C40058683EA767135BA7B
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Additional information on reviewing provincially available datasets is available in 
Appendix A: 3. 

Optimizing layer visualization 
When visualizing data layers in a geographic information system (GIS), it may be 
advantageous to make each layer partially transparent to visually consider multiple layers 
at once. To optimize the mapping experience, it may be advantageous to strategically 
arrange the order of relevant layers (Appendix A: 2). 

2 Desktop Assessment Survey123 
How to interpret question guidance 
Each Desktop Assessment question described below includes recommended datasets, 
analysis process, and in some cases additional guidance to consider when answering each 
question. The description for each question may not include every component, but 
generally follows a similar structure as shown in the pop-out box below. 

 
  

OF#: The indicator that corresponds to the Survey123 question and other 
WESP-BC resources  

Relevant layers and datasets: 
o Links to layers that may be beneficial to consider  
o Aerial Imagery – may also be listed if key to consider 

“Exact question as described on the Survey123 form” 

Notes:  
• Additional hints or helpful information may be included in a note. This is 

typically also included in the Survey123 form 

Question options including specification of answer format (select one, select 
multiple, integer, decimal etc.):  

o Options or text data 
o Formatted to match Survey123 form options 

1. Specific steps to complete analysis will be included,  
i. These steps may include links to specific appendix resources. 

2. If the answer is obvious from reviewing datasets and imagery these 
steps may not be required to complete for all sites 
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OF 1: Distance to community  
Relevant layers and datasets:  

o Assessment Area (AA) 
o Aerial Imagery 
o Municipalities - Legally Defined Administrative Areas of B.C. 

“The distance from the AA's edge to the nearest settlement (>5 residences per square 
km) or legally recognized municipality or community is:” 

Notes: 
• Settlements can include clusters of homes, small communities, municipalities, or 

reserves. Use your judgment based on visible infrastructure and settlement patterns 
• When there is a cluster of 5 or more residences within 1 km2, measure the distance 

to the nearest of those residences 
• Use the most recent imagery to visually inspect the area. Apply buffers or the 

measure tool to determine the distance to the nearest residential area 

Select one of the following: 
o < 100 m 
o 100 - 500 m 
o 500 m - 1 km 
o 1 - 5 km 
o > 5 km 

OF 2: Distance to frequently travelled road 
Relevant layers and datasets: 

o B.C. Cumulative Effects Framework – Integrated Roads – 2025 
o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 
o Aerial Imagery 

“The distance from the AA center to the nearest road with an average daytime traffic 
rate of > 1 vehicle/ minute is:” 

Notes:  
• Only consider paved roads, confirm with aerial imagery or the Digital Road Atlas for 

road classification. DO NOT include trails, ATV routes, or unmaintained roads 

Select one of the following: 
o < 10 m 
o 10 - 25 m 
o 25 - 50 m 

https://catalogue.data.gov.bc.ca/dataset/e3c3c580-996a-4668-8bc5-6aa7c7dc4932
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
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o 50 - 100 m 
o 100 - 500 m 
o > 500 m 

1. Add the relevant layers/datasets 
2. Adjust the symbology for clarity 
3. Measure the distance from the center of the AA to the nearest main paved road, 

or use the buffers to visually determine distance to the nearest road 
 

OF 3: Distance to ponded water 
Relevant layers and datasets: 

o Aerial Imagery 
o Freshwater Atlas – Lakes 

“The distance from the AA edge to the closest (but separate) body of fresh water 
(wetland, pond, or lake) that is ponded all or most of the year:” 

Notes:  
• This is to determine the distance from the AA to the nearest ponded freshwater 

feature (not rivers or streams) 
• Consider wetlands that may be separating ponded water and the AA such as:  paved 

roads, bare ground, or impervious surfaces 
• Focus on separate ponded features that do not appear to be part of the same 

continuous wetland 
• You may count ponded areas obscured by vegetation if imagery, seasonal 

differences, or where persistent saturation indicators suggest they are present 

Select one of the following: 
o <100 m, and NOT separated by any width of paved roads, bare ground, or 

impervious surface 
o <100 m, but completely separated by those features 
o 100 m-1 km, and not separated 
o 100 m-1 km, but separated by those features 
o 1-5 km, and not separated 
o 1-5 km, but separated by those features 
o None of the above (the closest patches or corridors that are large, are more than 5 

km away) 

1. Add the Freshwater Atlas – Lakes layer. 
2. Identify the AA and use the Freshwater Atlas – Lakes and ESRI imagery 

basemap or other aerial imagery to visually locate nearby ponded water 

https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
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3. Measure from the edge of the AA to the nearest ponded feature: 
i. If separated by roads, bare ground, or impervious surfaces wider than 

100 m, treat that body of water as being separate from the AA 

OF 4: Distance to lakes 
Relevant Layers and Datasets: 

o Aerial Imagery 
o Freshwater Atlas – Lakes 

“The distance from the AA edge to the closest (but separate) ponded water body 
larger than 8 hectares during most of a normal year is:” 

Notes:  
• Ensure the lake is within the 10 km buffer (lakes smaller than 8 ha should be 

excluded) 
• In ArcGIS Pro, the Select Features by Location tool may be used to highlight 

Freshwater Atlas – Lakes within 10 km of the AA. This list may then be filtered to 
lakes greater than 8 ha 

Select one of the following: 
o <100 m 
o 100 m-1 km 
o 1-5 km 
o 5-10 km 
o >10 km 

1. Consider Buffer_10km. 
2. Identify the AA and use the imagery basemap to visually locate the nearest lake 

(ponded water > 8 ha) 
3. Measure from the edge of your AA to the nearest lake. 

OF 5: Relative elevations in watershed 
Relevant Layers and Datasets: 

o Digital Elevation Model layer(s). Alternatively elevation data from visual inspection 
on Google Earth 

o Freshwater Atlas – Assessment Watersheds 
o Assessment Area polygon (AA_polygon) 

“Relative elevation = (AA Elevation – Minimum Elevation)/Elevation Range of 
Watershed)” 

https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
https://pub.data.gov.bc.ca/datasets/175624/
https://catalogue.data.gov.bc.ca/dataset/freshwater-atlas-assessment-watersheds
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Notes: 
• Ensure usage of the Freshwater Atlas – Assessment Watersheds layer. 

Assessment Watersheds Units (WAUs) were designed for understanding elevation a 
local context 

Input Decimal Value (0 to 1.0): 

1. Add the Assessment Area and the Freshwater Atlas – Assessment 
Watersheds layer. 

i. Use the Select tool on the Assessment Watersheds Layer and select the 
watershed that intersects the AA 

ii. Then create a separate shapefile of just that Assessment Watersheds unit. 
If multiple watersheds exist, choose the largest one 

iii. Add relevant DEM layer(s), by selecting all DEMs that overlap with the 
Assessment Watersheds unit. DEM layers are packaged in grids like a 
checkerboard, and you may need more than one to complete this task. This 
will require that you look up the appropriate reference map sheets to 
download the appropriate DEMs. Looking up the mapsheet reference 
numbers is possible on iMap BC by adding and viewing layers: Basemaps – 
Mapsheet Grid 20K, and then recording the alphanumeric numbers of the 
grids of interest. You can then download the associated DEM(s) from BC 
data warehouse 

iv. Use the Mosaic to New Raster tool to combine adjacent DEMs into one 
raster 

v. Clip or Extract by mask the aggregate DEM raster with your Assessment 
Watersheds unit to create a DEM just for the watershed of interest 

vi. Now you can use the Attribute Table, or Get Raster Properties, to record 
the minimum and maximum elevations of the watershed 

vii. Alternatively, to skip steps iii to step vi, you can save and then import a kml 
layer of your Assessment Watersheds layer and your AA into Google Earth. 
Determine the maximum and minimum elevation of the AA’s watershed 
(not the AA’s catchment). Then subtract the watershed minimum elevation 
from the AA’s median elevation, divide by the watershed’s elevation range 
(max-min) (see formula in number 2). Assessment Watersheds 

2. Calculate relative elevation using the formula below: 

𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑 𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄 =
𝐀𝐀𝐀𝐀 𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄 −𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌 𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄 𝐢𝐢𝐢𝐢 𝐭𝐭𝐭𝐭𝐭𝐭 𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰𝐰

𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄 𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑𝐑 𝐨𝐨𝐨𝐨 𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖𝐖
  

3. Input decimal value (0 to 1.00) 

https://maps.gov.bc.ca/ess/hm/imap4m/
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o This calculation expresses the AA’s elevation relative to its watershed: 
whether it lies near the bottom, middle, or top (headwater) of the 
watershed 

OF 6: Stream intersect 
Relevant Layers and Datasets: 

o Aerial Imagery 
o Freshwater Atlas – Assessment Watersheds 
o Freshwater Atlas – Stream Directions – Points 
o Freshwater Atlas – Stream Network – Lines, Edge Type 
o Freshwater Atlas – Rivers 

“Do topographic maps or the Freshwater Atlas show a stream flowing out of the AA's 
wetland and into a downslope stream network, or does the AA abut a stream/river 
and is probably flooded by the stream/river periodically?” 

Notes:  
• In the Freshwater Atlas – Stream Network, the following line types should be 

ignored unless field observations indicate otherwise: 
o Flow Connector 
o Isolated Waterbody Skeleton 
o Underground Connector 
o Inferred Connector 

Select one of the following: 
o Yes 
o No 

1. Add the relevant layers/datasets. 
2. To symbolize streams: 

i. In the Contents pane, right-select the layer (for example, Stream Network) 
> Symbology > set Primary Symbology = Unique Values. 

ii. In the Field drop-down, select EDGE_TYPE 
iii. Add All Values except for the above specified line types 

3. Visually inspect whether the AA polygon intersects with valid streams or rivers 
i. Use aerial imagery and stream direction points to confirm flow direction 

4. Interpret results: 
i. If a clear stream flows out of the AA and connects to the downslope 

network → Yes 
ii. If the AA abuts a river that can flood it periodically → Yes 
iii. Otherwise → No 

https://catalogue.data.gov.bc.ca/dataset/freshwater-atlas-assessment-watersheds
https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/f7dac054-efbf-402f-ab62-6fc4b32a619e
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
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OF 7: Aspect 
Relevant layers and datasets: 

o Elevation or slope and aspect raster (for example, RESULTS Openings Slope Aspect 
and Elevation) 

o Topographic contours (for example, TRIM Contour Lines, Local Government 
mapping contour lines) 

 
“The overland flow direction of most surface water (in streams, rivers, or runoff) that 
enters the AA is: N, NE, S, SE, E SE, W, NW, or flat” 
 
Note:  

• If flow direction is unclear or diffuse, consider the mean aspect of the surrounding 
watershed. 

Select one of the following: 
o Northward (N, NE), north-facing contributing area 
o Southward (S, SW), south-facing contributing area 
o Other (E, SE, W, NW), or no detectable uphill slope or input channel (flat) 

 
1. Add the AA polygon and an elevation or slope/aspect raster 

i. For easier interpretation, add a Hillshade or Aspect raster (for example, BC 
DEM Hillshade) 

ii. Alternatively, use the Topographic basemap  
2. Assess the surrounding terrain: 

i. Identify the dominant slope direction draining into the AA 
ii. Look for elevation patterns, flow channels, or upslope contributing areas 
iii. Use contour lines to confirm slope gradients in upland areas 

3. Determine dominant flow direction entering the AA: 
i. Consider slope, stream direction, and landform orientation 

ii. If no clear slope or channel exists, treat the AA as “Flat” 
4. Select the best category: 

i. If flow originates from a south-facing slope (flowing south), choose 
Southward (S, SW) 

ii. If flow originates from a north-facing slope (flowing north), choose 
Northward (N, NE) 

iii. If flow comes mainly from E, SE, W, NW, or terrain is flat, choose Other 

OF 8: Glacier influence 
Relevant layers and datasets:  

o Freshwater Atlas – Stream Directions  
o Freshwater Atlas – Stream Network 

https://catalogue.data.gov.bc.ca/dataset/57b8ba13-cd01-43a5-9910-bc18375426d0
https://catalogue.data.gov.bc.ca/dataset/57b8ba13-cd01-43a5-9910-bc18375426d0
https://catalogue.data.gov.bc.ca/dataset/8edde26d-aea0-47e9-bab1-e7c6226181ae
https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
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o Freshwater Atlas – Glaciers 
o Glaciers 

 
Notes:  

• Consider whether the AA is in a glacial-influenced watershed or is located sufficiently 
downstream to experience negligible influence regarding temperature or turbidity 
from the glacier 

Select the first true choice: 
o No glacier capable of contributing surface flow to the AA is present upstream. If a 

glacier is present, there is no surface connection to the AA 
o Glacier connected by streams to the AA is present upstream, but clarity or 

temperature of the AA's surface water is seldom or never affected (because it is too 
distant from glacier) 

o Glacier connected by streams to the AA is present upstream and the clarity or 
temperature of the AA's surface water is regularly affected 
 

1. Add the relevant layers/datasets 
2. To check upstream of the AA, zoom to the AA polygon and pan upstream within 

the watershed 
i. Identify any mapped glaciers in the watershed 
ii. Use the “Freshwater Atlas – Stream Network” and “Freshwater Atlas – 

Stream Directions” to confirm if a surface water connection exists between 
the glacier and the AA 

3. Interpret results: 
i. If no glacier is upstream or no surface connection exists, select Option 1 
ii. If a glacier is connected by streams but is too distant to affect water clarity 

or temperature, select Option 2 
iii. If a glacier is connected by streams and regularly influences AA water 

clarity/temperature, select Option 3 

 OF 9: Floodable infrastructure 
Relevant layers and datasets:  

o Aerial Imagery 
o Freshwater Atlas – Rivers 
o Freshwater Atlas – Stream Network 
o Freshwater Atlas – Stream Directions 
o BC Cumulative Effects Framework – Integrated Roads – 2025 
o Freshwater Atlas – Assessment Watersheds 

 

https://catalogue.data.gov.bc.ca/dataset/8f2aee65-9f4c-4f72-b54c-0937dbf3e6f7
https://catalogue.data.gov.bc.ca/dataset/832b4523-7853-4ec5-8f9c-4314a0154927
https://catalogue.data.gov.bc.ca/dataset/f7dac054-efbf-402f-ab62-6fc4b32a619e
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/freshwater-atlas-assessment-watersheds
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“Is there infrastructure that is at risk of flooding within 5 km of the wetland?” 
 
Notes:  

• Do not include agricultural fields, gravel pits, or other mined lands unless clearly 
built-up with public infrastructure 

• Infrastructure is considered vulnerable if: 
o It has experienced flood damage in the past 100 years without protection 
o It lies within a mapped 100-year floodplain, or  
o It is in an alluvial floodplain and less than 3 m above the expected annual 

high water (for example, bankfull stage) 
• Consider infrastructure features lying downstream or downslope within the same 

watershed. Consider whether upstream wetlands may mitigate flood risk; if none are 
relevant, record as “none” 

• The “watershed” refers to the Freshwater Atlas - Assessment Watersheds layer 
• Consider temporary damming effects from ice jams that could occur downstream in 

the vicinity of the AA 

Select the first true choice: 
o Within 1 km: Infrastructure vulnerable to river flooding is present downstream or 

downslope within 1 km of the AA and in the same watershed 
o Within 5 km: Infrastructure vulnerable to river flooding is present downstream or 

downslope within 5 km of the AA in the same watershed 
o >5 km: Infrastructure vulnerable to river flooding is present downstream or 

downslope at a farther distance but within the same watershed 
o None: No infrastructure vulnerable to river flooding is present downstream or 

downslope in the AA's watershed 
 

1. Consider Buffer_5km (Appendix-A) 
2. Use the Measure tool to identify infrastructure within the buffer that is: 

i. Close to stream channels or rivers flowing downstream or out of the AA 
ii. Located on the floodplain or visibly near channels within low-lying areas 

3. Look for indicators of potentially flood-vulnerable infrastructure, including: 
i. Buildings 

ii. Bridges 
iii. Actively used roads 
iv. Pipelines 

 

OF 10: Internal flow distance 
Relevant layers and datasets:  

https://catalogue.data.gov.bc.ca/dataset/freshwater-atlas-assessment-watersheds
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o Aerial Imagery 
o Freshwater Atlas – Stream Directions   
o Freshwater Atlas – Stream Network 

 
“How long is the stream that is intersecting the wetland?” 
 
Notes:  

• This measurement represents the internal flow path through the AA 
• If wetland has both an inlet and outlet, measure the distance between them. Use 

elevations to determine which are inlets and which are outlets and augment with 
field inspection 

• If outlet only, measure the maximum straight-line distance within the wetland from 
that point 

• If neither inlet nor outlet, measure wetland's maximum dimension (distance in a 
straight line from highest to lowest elevation).  

• If wetland receives surface water only during annual flooding from an adjoining 
river, measure the distance along a line from wetland's upland edge extending 
perpendicular to the source channel.  

Select one of the following: 
o < 10 m 
o 10-50 m 
o 50-100 m 
o 100 m-1 km 
o 1-2 km 
o > 2 km, or the wetland lacks an inlet or outlet 

1. Add the relevant layers and datasets:  
i. Add the stream network layer prepared in OF 6 (with invalid EDGE_TYPE 

values removed) 
ii. Add aerial imagery for visual confirmation 

2. Identify inlets and outlets by using stream directions and elevation/contours to 
determine inflow vs. outflow points 

3. Open the Measure tool (consult Appendix A-8) to trace the channel path from 
inlet to outlet within the AA boundary, selecting along bends to capture 
curvature. 

i.  If mapped streams differ from visible/field-observed channels, use the 
observed channel 

4. If multiple streams exist, measure each candidate segment, and record the 
longest measure length as the internal flow distance 

https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
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5. If no mapped stream is present, use elevation data/contour lines to estimate 
the straight-line distance between the highest and lowest points within the AA 

6. Record the results length in meters and select the correct category 
 

OF 11: Wetland as a percentage of its contributing area (catchment)  
Relevant Layers and Datasets:  

o wetland_entire polygon 
o aerial imagery 
o Freshwater Atlas – Stream Directions  
o Freshwater Atlas – Stream Network 
o Freshwater Atlas – Watershed Boundaries 

 
“How big is the wetland relative to the contributing area?”  
 
Notes:  

• From a topographic map, aerial imagery, and field observations, estimate the 
approximate boundary of the area that is upslope from the lowest part in the 
wetlands, and that is likely to contribute surface or ground water to the wetland (i.e., 
the wetland’s contributing area). No streams or ditches should cross that boundary. 
Adjust the boundary if necessary based on your field observations of the 
surrounding terrain  

• When calculating area, if ponded deeper water abuts the wetland, include that in the 
wetland’s area 

• Wetlands that are located in areas with flat surrounding terrain and no inlet, or is 
entirely isolated by dikes, in an isolated basin (e.g., In flat, headwater areas or 
isolated basins, the wetland may be larger than its effective catchment 

Select one of the following: 
o <1%, or contributing area is unknown due to stormwater pipes that collect water 

from an indeterminate area 
o 1-10% 
o 10-100% 
o >100%, wetland is larger than its contributing area (for example, headwater 

wetland with flat surrounding terrain and no inlet, or entirely isolated by dikes, or a 
raised bog). Skip to OF13 

 
1. Check and calculate areas: 

i. Confirm area fields for both AA polygon and “wetland_entire polygon” (m² 
or hectares) 

https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/ab758580-809d-4e11-bb2c-df02ac5465c9
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i. If in m2 convert to hectares (Shape_Area ÷ 10,000).  
2. Calculate wetland % relative to the CA: 

i. Use formula below: 

Wetland % relative to the CA =
AA Area

wetland_entire polygon
 

ii. Record results as a percentage and select the appropriate category 

OF 12: Unvegetated Surface in the Wetland’s Assessment Watersheds Unit (WAU): 
Relevant Layers and Datasets:  

o Aerial Imagery 
o Freshwater Atlas Assessment Watersheds 
o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 

 
“The proportion of the wetland Assessment Watershed comprised of buildings, 
roads, parking lots, other pavement, or bare soil at the time of peak annual runoff is 
about:” 
 
Notes:  

• The Assessment Watersheds unit (WAU), refers to the Freshwater Atlas Assessment 
Watersheds layer. The BC Data Catalogue states: “Assessment Watersheds are 
mesoscale aquatic units designed to replace the 3rd order 1:50K watersheds. 
Assessment Watersheds are based on groupings of fundamental watersheds using 
FWA watershed code and local code, with a target size of between 2,000 ha and 
10,000 ha” 

• Estimate the total area of unvegetated or impervious surfaces (for example, 
buildings, pavement, bare ground) within the WAU 

Select one of the following: 
o <10% 
o 10-25% 
o >25% 

 
1. Scan the WAU for unvegetated/impervious surfaces by using aerial imagery 

i. Look for paved roads, parking lots, rooftops, bare soil, gravel, or rocky 
outcrops 

ii. Exclude temporary features (for example, cutblocks) 
2. Use the Digital Road Atlas (DRA) layer to confirm paved and developed road 

segments 
3. Visually estimate % of the WAU covered by impervious/unvegetated surfaces 

while considering the answer categories 

https://catalogue.data.gov.bc.ca/dataset/97d8ef37-b8d2-4c3b-b772-6b25c1db13d0
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
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i. If difficult to judge visually, use the Measure tool or digitized polygons 
around built-up areas to calculate 

4. Record and select the appropriate answer category 

OF 13: Conservation investment  
Relevant Layers and Datasets:  

o No layers required 

“The AA is within or abuts a wetland on which public or private organizational funds 
were spent to preserve, create, restore, or enhance the wetland. If unsure, ask the 
property owner.”  
 
Notes:  

• No review of spatial information required 
• This question relies on local information and research on of the site. If not already 

known, contact the landowner or local authority to determine whether conservation, 
restoration, or enhancement funds were invested in the wetland 

Select one of the following: 
o Yes 
o No 

OF 14: Sustained Scientific Use 
Relevant Layers and Datasets:  

o No layers required 
 

“Has there been sustained scientific use of the wetland?” 
 
Notes:  

• No review of spatial information is required 
• This question relies on local information. Consider whether the AA has been 

monitored for more than 2 years (plants, animals, or water), with data available to 
the public and not tied to regulatory requirements. Also, check if the AA is part of a 
designated benchmark, reference, or status-trends monitoring area. If the wetland is 
within a park or conservation area, do a quick search to confirm whether monitoring 
or research has been conducted 

Select one of the following: 
o Yes 
o No 
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OF 15: Burned 
Relevant Layers and Datasets:  

o BC Wildfire Fire Perimeters – Historical 
 

“Has any part of the Assessment Area (AA) burned since 2010?” 
 
Notes:  

• The 100 m distance accounts for fire effects that may extend slightly beyond the 
mapped perimeter 

Select one of the following: 
o Yes 
o No 

 
1. Add the layer and ensure the AA polygon is visible 
2. Visually inspect whether a fire perimeter overlaps the AA or extends within 100 

m of the boundary 
i. If needed, check the burn year attribute to confirm whether the fire 

occurred within the last 25 years 

OF 16: Karst geology 
Relevant layers and datasets:  

o Reconnaissance Karst Potential Mapping  
 

“The AA's wetland is within a geologic unit having a significant karst (limestone, 
calcium carbonate) component.”  
 
Notes:  

• Visual confirmation from local experts or detailed geological mapping is 
recommended where karst presence is suspected 

• "Other information" may include advice of qualified geologists or other maps of local 
geology 

Select one of the following: 
o Yes 
o No 

 
1. Add the Reconnaissance Karst Potential Mapping layer 
2. Arrange layers so the karst layer is displayed above the AA polygon 

https://catalogue.data.gov.bc.ca/dataset/22c7cb44-1463-48f7-8e47-88857f207702
https://catalogue.data.gov.bc.ca/dataset/395568e1-d233-4217-9732-7afadb6f4265
https://catalogue.data.gov.bc.ca/dataset/395568e1-d233-4217-9732-7afadb6f4265
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3. Check if the AA overlaps areas classified as High (H) or Medium (M) karst 
potential. Open Attribute Table, or identify results for any Karst polygon 
overlaying the wetland, and examine field KA_DEV_INT, if H (high) or M 
(medium), select “Y” 

4. If no karst layer is available: 
i. Use regional geology layers or maps showing limestone-rich 

Paleozoic/Mesozoic formations 

OF 17: Geologic faults 
Relevant layers and datasets:  

o Geology Faults 
 
“The AA's wetland abuts or is intersected by a geologic fault.” 

Select one of the following: 
o Yes 
o No 

 
1. Add the Geology Faults layer. 
2. Compare with the AA:  

i. Ensure both the wetland (AA) and the fault line layer are visible 
ii. Arrange layers so the fault line layer is displayed above the “AA” polygon 
iii. Visually inspect whether any fault lines cross or touch the AA boundary 

3. If difficult to determine by visual inspection (such as on very large sites) then 
consider using the intersect tool (Appendix A: 9) 

OF 18: Lakes within 2 km of the AA 
Relevant layers and datasets:  

o Aerial Imagery 
o Freshwater Atlas – Lakes 

 
“Considering Freshwater Atlas-Lakes, consider the 2km buffer. Based on visual 
estimation or measurement, the percentage of that circle occupied by lakes is:” 
 
Notes:  

• Focus only on permanent open-water lakes 
• Exclude wetlands, ephemeral ponds, and seasonal water bodies unless clearly 

mapped as lakes for this question (these other areas are considered in OF19) 

Select one of the following: 
o <2% 

https://catalogue.data.gov.bc.ca/dataset/c94e0c13-5385-49c1-9922-822e10135fc6
https://catalogue.data.gov.bc.ca/dataset/c94e0c13-5385-49c1-9922-822e10135fc6
https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
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o 2-7% 
o 8-17% 
o 18-34% 
o >34% 

 
1. Consider the Freshwater Atlas – Lakes layer  

i. Visually inspect if there are any lakes within the 2km buffer 
ii. If it is difficult to determine the precise area coverage of these features, 

then follow steps 2- 5 to determine the areas 
2. Clip wetland layers to buffer boundary (see Appendix A-12) 

i. ii. Save as Lakes_clipped_2km polygon 
3. Calculate total areas using Calculate Geometry (see Appendix A-10).4. 

Calculate the total buffer area: 
i. In the Attribute Table of Buffer_2km, add a field for buffer area (for 

example, Buffer_Ha) 
ii. Use Calculate Geometry to populate the buffer area in hectares (see 

Appendix A-10) 
4.   Calculate the total buffer area using the formula below: 

Lake % of Buffer =  
Total Lake Area

Total Buffer Area 
 X 100 

 

OF 19: Wetlands and lakes within 2 km of the AA 
Relevant layers and datasets:  

o Freshwater Atlas – Lakes 
o Freshwater Atlas – Wetlands 

 
“Also load this layer: Base Maps> Freshwater Atlas> Wetlands. Based on visual 
estimation, the percentage of that circle occupied by wetlands AND lakes combined 
is:” 
 
Notes:  

• You can combine the lakes and wetlands layers before measuring (for example, 
using the merge layers tool (See Appendix A-10), then calculate the combined area in 
a single step 

• Consider permanent open water as well as mapped wetland areas within the buffer 
• This value should be larger than the value of OF 18 which only considered lakes 

within 2 km 

Select one of the following: 
o <2% 

https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
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o 2.1-7%  
o 8-17%  
o 18-34% 
o >34% 

 
1. Consider the dataset created in OF 18. 

i. Visually inspect if there are any lakes or wetlands within the 2km buffer 
ii. If it is difficult to determine the precise area coverage of these features, 

then follow steps 2-4to determine the areas 
2. Clip wetland layers to buffer boundary (see Appendix A-13) 

i. ii. Save as Wetlands_clipped_2km. 
3. Calculate total areas using Calculate Geometry (see Appendix A-11). 
4. Use the formula below to answer the question: 

Wetland + Lake % of Buffer =  
Lake Area + Wetland Area

Buffer Area
 X 100 

OF 20: Fish occurrence 
Relevant Layers and Datasets:  

o BC Historical Fish Distribution – Points (50,000) 
 The following iMapBC layer is required:  

o Fish Wildlife and Plant Species > All Fish Points 
 
“Score all the conditions below that are true based on your own observations, 
information from agency biologists, or this iMapBC layer: Fish Wildlife and Plant 
Species> All Fish Points (use the Identify tool and select on the points to see the 
species reported).” 
 
Notes:  

• Watershed connectivity and proximity determine the appropriate score option 
(within AA, within 8 km, or in connected parts of the watershed) 

• Only wild, not stocked fish should be considered 

Select all that are true: 
o Chinook are present in AA 
o Chinook in connected parts of same watershed within 8 km 
o Chinook in other connected parts of the same watershed 
o Chum are present in AA 
o Chum are in connected parts of same watershed within 8 km 
o Chum are in other connected parts of the same watershed 
o Coho/Silver are present in AA 
o Coho/Silver are in connected parts of same watershed within 8 km 

https://catalogue.data.gov.bc.ca/dataset/3b723ef2-abd4-4722-abea-9a51258eae15
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o Coho/Silver are in other connected parts of the same watershed 
o None of the above, but other fish species are likely present in AA. Or a stream 

connects the AA to other waters and is not known to be fishless 
o Is known or likely to be fishless (for example, too small, dryor not accessible even 

temporarily, and not stocked) 

OF 21: Ecological designation 
Relevant layers and datasets:  

o BC Parks, Ecological Reserves, and Protected Areas  
o Conservation Lands 
o Critical Habitat for Federally-Listed Species at Risk – Posted 
o Designated Lands 
o Species and Ecosystems at Risk - Publicly Available Occurrences - CDC  
o Ungulate Winter Range – Approved 
o TANTALIS – Conservancy Areas  
o TANTALIS – Wildlife Management Areas 

 
“Is the AA within or abuts a public or private area designated by government (public 
or First Nations), Nature Conservancy, or a conservation land trust for its heightened 
ecological importance?”  
 
Notes:  

• Ecological designations may include areas with legal protection, management 
restrictions, or recognized ecological value 

• Designations vary by jurisdiction; confirm data sources are current before analysis 

Select one of the following: 
o Yes 
o No 

 
1. Add the relevant layers/datasets 
2. Consider Buffer_100m 
3. Use Intersect to compare Buffer_100m with the designated lands layer (see 

Appendix A-9) and save it as AA_DesignatedOverlap wherever a relevant layer 
overlaps with the 100 m buffer 

4. Review the designation: 
i. Open the Attribute Table of AA_DesignatedOverlap 
ii. Locate the field indicating designation type (for example, park, ecological 

reserve) 

https://catalogue.data.gov.bc.ca/dataset/1130248f-f1a3-4956-8b2e-38d29d3e4af7
https://catalogue.data.gov.bc.ca/dataset/68327529-c0d5-4fcb-b84e-f8d98a7f8612
https://catalogue.data.gov.bc.ca/dataset/076b8c98-a3f1-429b-9dae-03faed0c6aef
https://github.com/bcgov/designatedlands/releases/download/v0.1.0/designatedlands.gpkg.zip
https://catalogue.data.gov.bc.ca/dataset/0e035e55-f257-458f-9a96-80c01c69d389
https://catalogue.data.gov.bc.ca/dataset/712bd887-7763-4ed3-be46-cdaca5640cc1
https://catalogue.data.gov.bc.ca/dataset/550b3133-2004-468f-ba1f-b95d0e281e78
https://catalogue.data.gov.bc.ca/dataset/f3ece977-aa7f-4cb2-b7d0-de64155f6c83https:/bcwildlife-my.sharepoint.com/personal/wew_bcwf_bc_ca/Documents/Wetlands%20Workforce/GIS/WESP/2025/2025%20Full%20GIS%20Analysis%20Guide/GIS%20Manual%202025%20V3%20(09.04).dotm
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iii. Confirm whether the wetland lies within or abuts a designated ecological 
area. 

OF 22: Protection from Intensive Uses 
Relevant Layers and Datasets:  

o Designated Lands 
o Conservation Lands 
o NGO Conservation Areas – Fee Simple 
o BC Parks, Ecological Reserves, and Protected Areas 
o Species and Ecosystems at Risk - Publicly Available Occurrences - CDC 
o TANTALIS – Wildlife Management Areas 
o TANTALIS – Conservancy Areas 

 
“Are new timber harvest, roads, mineral extraction, and intensive summer recreation 
(for example, off-road vehicles) permanently prohibited from the AA?” 
 
NOTES:  

• Consider any lands that contribute to conservation, such as those with legal 
protection, management restrictions, or excluded activities (for example, parks and 
protected areas, other protected areas). If such designations occur in or directly 
adjacent to the assessment area, record them here. 

Select one of the following: 
o Yes 
o No 

1. If any of the above layers intersect with the AA, then select “Yes” 

OF 23: BGC protection percentage 
The following iMapBC layer is required:  

o Forest Grasslands and Wetlands > Percent BGC Subzone Variant Protected  
 
“What percent of the wetland's biogeoclimatic subzone variant is protected?:” 
 
Notes:  

• Assign the AA to the BGC subzone variant covering the largest portion of the wetland 
• In iMapBC, go to the folder titled: Forest, Grasslands and Wetlands; then select the 

layer titled Percent BGC Subzone Variant Protected (colour theme), the colours will 
display the percent breakdown 

• The dataset reports the protected percentage in the Percent of Biogeoclimatic Unit 
Protected field 

https://github.com/bcgov/designatedlands/releases/download/v0.1.0/designatedlands.gpkg.zip
https://catalogue.data.gov.bc.ca/dataset/68327529-c0d5-4fcb-b84e-f8d98a7f8612
https://catalogue.data.gov.bc.ca/dataset/a306e21b-58d6-4b71-bac7-f3b1c8a4c779
https://catalogue.data.gov.bc.ca/dataset/1130248f-f1a3-4956-8b2e-38d29d3e4af7
https://catalogue.data.gov.bc.ca/dataset/species-and-ecosystems-at-risk-publicly-available-occurrences-cdc
https://catalogue.data.gov.bc.ca/dataset/f3ece977-aa7f-4cb2-b7d0-de64155f6c83
https://catalogue.data.gov.bc.ca/dataset/550b3133-2004-468f-ba1f-b95d0e281e78
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• This value reflects the percentage of the entire BGC subzone variant that is protected 
at the provincial scale, and not local conditions around your AA 

Select one of the following: 
o 0-1% 
o 1-4% 
o 4-8% 
o 8-12% 
o 12-20% 
o > 20% 

 
1. Use Select Layer by Location to select BGC polygons that intersect the AA: 

i. Open the Attribute Table of selected features 
ii. If multiple subzones overlap, determine which subzone covers the largest 

portion of the AA 
2. Use Calculate Geometry if needed to measure overlap areas. 
3. Determine the protection percentage: 

i. In the Attribute Table of the dominant BGC polygon, locate the field 
reporting the percent protected value, record the value, and select the 
appropriate category 

OF 24: Species of conservation concern 
Relevant layers and datasets:  

o Species and Ecosystems at Risk - Publicly Available Occurrences - CDC 
o Wildlife Species Inventory – Incidental Observations – Publicly Available  
o Wildlife Species Inventory – Survey Observations – Publicly Available  
o Wildlife Species Inventory - Telemetry Points – Publicly Available 
o Wildlife Habitat Features – Incidental Observations – Publicly Available  
o Wildlife Habitat Features – Survey Observations – Publicly Available  

 
“Are there species of conservation concern (in the list below) that have been 
observed within a 500 m buffer of the AA?” 
 
Notes:  

• To identify species of concern near your wetland: 
o If possible/relevant, Consult Experts: Regional biologists, First Nations 

knowledge holders, and agency staff 
o Check Public Databases: List of provincial datasets as listed above 

https://catalogue.data.gov.bc.ca/dataset/species-and-ecosystems-at-risk-publicly-available-occurrences-cdc
https://catalogue.data.gov.bc.ca/dataset/7d5a14c4-3b6e-4c15-980b-68ee68796dbe
https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-4e9f-a4b5-27e123972816
https://catalogue.data.gov.bc.ca/dataset/6d48657f-ab33-43c5-ad40-09bd56140845
https://catalogue.data.gov.bc.ca/dataset/wildlife-habitat-features-incidental-observations-publicly-available
https://catalogue.data.gov.bc.ca/dataset/wildlife-habitat-features-survey-observations-publicly-available
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• Use the BC Species and Ecosystems Explorer to identify Red/Blue-listed and SARA 
species. Review the: BC Conservation Data Centre (CDC), also consider: eBird.org 
(bird records), iNaturalist.org (citizen-science observations) 

o Request Restricted Data (if your project is eligible): Submit assessment 
area polygon(s) with a 500 m buffer specified to the BC Conservation Data 
Centre to cdcdata@gov.bc.ca for masked/proprietary CDC records 

o Consult the BC Species and Ecosystems Explorer for the current 
conservation status of each species that has occurrences within or nearby 
your wetland. Red, Blue, and SARA listed species should be considered as of 
conservation concern for this question 

o Identify species of conservation concern from the relevant layers within 500 
m of the AA 

Select all the species of conservation concern that have been observed within a 
500m buffer of the AA: 

o Any plant species or community of conservation concern 
o Any amphibian listed as being of conservation concern 
o Either of these waterbird species of conservation concern: American Bittern, Eared 

Grebe 
o Raptor or wetland songbird species of conservation concern: Broad-winged Hawk, 

Swainson's Hawk, Northern Goshawk, Peregrine Falcon, Prairie Falcon, Long-billed 
Curlew, Western Screech-owl, Short-eared Owl, Black Swift, Olive-sided Flycatcher, 
Barn Swallow, Cape May Warbler, and/or Rusty Blackbird 

o Caribou 
 

1. Use the Explore or Identify tool to obtain latitude/longitude coordinates. 
2. Copy these coordinates for use in species databases 
3. Review species records in available project-specific wildlife observation, eBird, 

iNaturalist, and any other available and relevant sources such as municipality 
datasets etc. Refer to notes above 

4. Confirm species presence, conservation status, and habitat context based on 
available data, and select options if any species of conservation concern is 
within 500 m. There are also text fields to document which species were 
identified 

OF 25: Local moisture deficit 
 
“In the next column, enter the CMD value (Annual) for the raster cell containing this 
wetland.” 
 

https://a100.gov.bc.ca/pub/eswp/
https://maps.gov.bc.ca/ess/hm/cdc/
https://ebird.org/home
https://www.inaturalist.org/
mailto:cdcdata@gov.bc.ca
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1. Using the online ClimateBC Map Viewer find the approximate location of your 
wetland on the map 

2. Select “Normal_1991-2020” in the “Historical” drop-down menu 
3. Record the CMD value (annual) for the raster cell containing this wetland 

 

OF 26: Degree days index 
 
“Enter the DD>5 value (Annual) for the raster cell containing this wetland.” 
 

1. Using the online ClimateBC Map Viewer to find the approximate location of 
your wetland on the map 

2. Select “Normal_1991-2020” in the “Historical” drop-down menu 
3. Record the DD5 value (annual) for the raster cell containing this wetland 

OF 27: Local solar input 
 
“Enter the sum of RAD_sp and RAD_sm values (Seasonal) for the raster cell containing 
this wetland.” 
 

https://climatebc.ca/
https://climatebc.ca/
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1. Using the online ClimateBC Map Viewer find the approximate location of your 
wetland on the map  

2. Select “Normal_1991-2020” in the “Historical” drop-down menu 
3. Record the sum of RAD_sp and RAD_sm values (seasonal) for the raster cell 

containing this wetland 

 

OF 28: Site index (soil nutrients) 
Relevant Layers and Datasets:  

o VRI – YEAR – Forest Vegetation Composite Rank 1 Layer  
 

“Enter the mean Site Index for the AA. If VRI contains no data for this attribute at 
AA's location, leave blank.” 
 
Notes:  

• Use the mean SI if working with a wetland that spans multiple VRI polygons. If the 
site index is unavailable or the value is "NaN", leave this question blank 

Select one of the following: 
o <6.3% 
o 6.3 - 9.5% 

https://climatebc.ca/
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
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o 9.6 - 13.3% 
o 13.4 - 18.5% 
o >18.5% 

OF 29: Topographic position 
Relevant Layers and Datasets:  

o VRI – 2024 – Forest Vegetation Composite Polygons  
 

“Enter the predominant Site_Position_Meso code (C, D, F, L, M, T, or U) the assessment 
area If VRI contains no data for this attribute at the AA's location, leave the next cell 
blank.” 
 
Notes:  

• Use the provincial landform data to assign the appropriate slope position for the 
Assessment Area (AA). Landform codes include: 

o D = Depression (Valley, Local Valley in Plain) 
o F = Flat (Plains) 
o L = Lower slope 
o M = Middle slope (Gentle Slopes, Steep Slopes) 
o U = Upper slope (Hilltop in Valley, Headwaters) 
o T = Toe slope 
o C = Crest (Ridges and Peaks, Local Ridge in Plain) 

• If no T (Toe slope) or L (Lower slope) code is present for the AA, use the most 
applicable available code based on inspection of terrain 

 

OF 30: Road density within AA’s buffer (100 m) 
Relevant layers and datasets:  

o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 
o BC Cumulative Effects Framework – Integrated Roads 
o  Buffer_100m_NoWetland 

 
“Considering a buffer of 100 m from the AA's edge, identify visible roads and mapped 
roads in the Digital Road Atlas. The length (km) of all roads within that buffer, 
divided by the buffer's area, is:” 
 
Notes:  

• Include All road types (paved, unpaved, resource) within the buffer. Exclude the 
wetland area itself from calculations to avoid skewed density values 

• If the road layer is in meters, convert units to kilometers before calculating density 

https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
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Select one of the following: 
o < 0.12 km/km2  
o 0.12-0.30 km/km2  
o > 0.30 km/km2  

1. Consider the Buffer_100m_NoWetland layer 
2. Select intersecting roads: 

i. Add the Integrated Roads layer 
ii. Use Clip tool with Buffer_100m_NoWetland  (Spatial Relationship = 

Intersect) 
3. Export and calculate road length: 

i. Export the selected roads as AllRoads_100m. 
ii. In the Attribute Table, ensure the length field is in kilometers (see 

Appendix A-11) 
iii. Sum the total road length (see Appendix A-14). 

4. Open the Attribute Table of Buffer_100m_NoWetland 
i. Confirm area in km2 

5. Calculate road density using the formula below: 

Road Density =  
Total Road Length (km)
100m Buffer Area (km2)

 

OF 31: Road density within 2 km of the AA 
Relevant layers and datasets:  

o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 
o BC Cumulative Effects Framework – Human Disturbance 
o 2km_buffer_excluding_AA polygon 

 
“Consider the 2 km buffer from the AA. The length (km) of all roads within that 
buffer, divided by the buffer's area, is:” 

Select one of the following: 
o < 0.12 km/km2 
o 0.12-0.30 km/km2 
o > 0.30 km/km2  

 
1. Consider the 2km_buffer_excluding_AA 
2. Follow the same remaining steps as OF 30 to calculate total road length, buffer 

area, and road density. 

OF 32: Intactness of landscape within 2 km 
Relevant layers and datasets:  

o BC Cumulative Effects Framework – Human Disturbance 

https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
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o AAbuffer_2km_ excluding_AA 
 

“Within that 2-km buffer, the percentage that is natural or semi-natural is:” 

Select one of the following: 
o <5% 
o 5-30% 
o 30-60% 
o 60-90% 
o >90% 

 
1. Consider the 2km_buffer_excluding_AA 
2. Extract disturbance features only within the buffer by using Clip and save as 

HumanDisturbance_2km 
3. Reclassify land cover into two categories: 

i. Intact (Natural/Semi-Natural): forest, wetland, grassland, etc. 
ii. Not Intact (Disturbed): urban, agriculture, clearcuts, etc. 

4. Calculate intact percentage: 

Intact % =  
2km Buffer Area (km2) −  HumanDisturbance_2km (km2)

2km Buffer Area (km2)
 

OF 33: Mature and old growth forest within 2 km 
Relevant layers and datasets:  

o Old Growth Technical Advisory Panel (TAP) – Forest Seral Stage 
o AABuffer-2km 

“Within that 2-km buffer, the percentage of area mapped as old growth or mature 
from total forest area is:” 

Notes:  
• The percentage is relative to total forested area within the 2 km buffer, not total land 

area 

Select one of the following: 
o <5% 
o 5-30% 
o 30-60% 
o 60-90% 
o >90% 

1. Consider Buffer-2km layer 
2. Select for Mature and Old Growth classes: 

https://catalogue.data.gov.bc.ca/dataset/old-growth-technical-advisory-panel-tap-forest-seral-stage
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i. Open the Attribute Table of the forest layer 
ii. Open Select by Attributes to select features where the field DESCR = 

Mature OR class = Old 
3. Use Clip to extract forest features within the 2km_buffer_excluding_AA (see 

Appendix A-13) 
i. Save as Forests_within2km 

4. Clip the selected Mature + Old Growth subset the same way. 
i. Save as Mature_OldGrowth_within2km 

5. Use Calculate Geometry to find total hectares for Forests_within2km. 
i. Repeat for Mature_OldGrowth_within2km 

6. Determine the percentage using the formula below: 

𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌 +𝐎𝐎𝐎𝐎𝐎𝐎 𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆 % =  
𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌𝐌 +𝐎𝐎𝐎𝐎𝐎𝐎 𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆𝐆 𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅 𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀

𝐓𝐓𝐓𝐓𝐓𝐓𝐓𝐓𝐓𝐓 𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅 𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀
 𝐗𝐗 𝟏𝟏𝟏𝟏𝟏𝟏 

OF 34: Land cover type uniqueness 
Relevant layers and datasets:  

o B.C. Land Cover (if available) 
o VRI attribute bclcs_level_4 
o Sentinel Land Cover   
o AABuffer_1km 
o AABuffer_5km 

 
“Do any of the land cover types that are present in the AA comprise <1% of the land 
cover in the surrounding 1km or 5km buffers?” 

Notes:  
• In cases where available land cover mapping is inaccurate, defer to observed land 

cover types based on the most recent available imagery 
• Use the best available land cover classification and aerial image interpretation for 

your location to assess landscape diversity within 1 km and 5 km buffers around the 
wetland 

• Overlay the AA layer with each buffer (1 and 5 km) and identify ‘unique’ land cover 
types present in each to determine if some of the land cover types within the AA are 
rare compared to the surrounding areas 

• The quality of landcover classification layers varies in different locations. Consider 
the recommended relevant layers listed, or better versions if available for your 
location 

• The classes listed below from the various sources, provides examples of the level of 
detail the user is expected consider 

• Landcover types in the VRI attribute BCLCS: level 4 includes the following categories:  

https://catalogue.data.gov.bc.ca/dataset/vri-2024-forest-vegetation-composite-rank-1-layer-r1-
https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
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o TC = Treed-coniferous 
o TB = Treed-broadleaf 
o TM = Treed Mixed 
o ST = Shrub Tall 
o SL = Shrub Low 
o HE = Herb-Forbs 
o HG = Herb – Graminoids 
o BY = Bryoid 
o BM = Bryoid – Moss 
o BL = Byroid – Lichens 
o SI = Snow/Ice 
o RO = Rock/Rubble 
o EL = Exposed Land 

• With slightly different categories, the BC_Landcover layer (if available) considers: 
o Barren Land 
o Coniferous Forest 
o Cropland 
o Deciduous Forest 
o Estuary 
o Fresh Water 
o Grassland 
o Intertidal Zone 
o Marine Water 
o Mixed Forest 
o Riparian - Coniferous Forest 
o Riparian - Deciduous Forest 
o Riparian – Grassland 
o Riparian - Mixed Forest 
o Riparian - Shrubland 
o Shrubland 
o Snow and Ice 
o Subtidal Zone 
o Unclassified 
o Urban and Built-up 
o Wetland 

Select all that apply: 
o Yes, at least one land cover type within the AA comprises <1% of the area within the 

1 km buffer of the AA (and outside of the AA)  
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o Yes, at least one land cover type within the AA comprises <1% of the area within 5 
km of the AA (and outside of the AA)  

o Neither of the above 
 

1. To calculate land cover area by type in the AA, first Clip the best available land 
cover data using the AA polygon (see Appendix A-13) and save as 
AA_Landcover 

2. Consider the total area of the Buffer_1km and Buffer_5km layers and calculate 
if any land cover types that occur within the AA are rare within the buffers (<1% 
of area). If you can visually tell that none of the land cover types within the AA 
are rare in the buffers, then you can select c) and not continue any further 

3. To calculate the percentage of the buffer covered by any rare land cover types, 
use Intersect with the best available land cover data and each buffer (see 
Appendix A-9) 

i. Save the land cover layers as Landcover_1km, Landcover_5km 
4.  If your land cover source is a shape file, then calculate the area of each land 

cover type using Calculate Geometry (see Appendix A-11): 
i. Divide each land cover area from the AA by the land cover area in the total 

buffer area to get a percentage 
ii. Identify any types where coverage is <1% 

5. If your landcover file is a raster, you’ll need to use the Build Raster Attribute 
Table, and select the overwrite option, to generate a new pixel count of each 
class in the clipped raster. You can obtain percentages based on relative pixel 
counts 

OF 35: Maximum dominance of a land cover type 
Relevant Layers and Datasets:  

o B.C. Land Cover (if available) 
o VRI attribute bclcs_level_4 
o Sentinel Land Cover   

 
“Identify the most extensive land cover type within the AA and calculate it as a 
percent of the total area.” 

Notes:  
• If there's only one type of land cover in the AA, such as coniferous, the answer would 

be 1. If the wetland is made up of 60% grassland and 40% mixed forest, then the 
answer would be 0.6.  

https://catalogue.data.gov.bc.ca/dataset/vri-2024-forest-vegetation-composite-rank-1-layer-r1-
https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
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1. Use the same landcover layer from analysis in OF34 (step 1). Calculate the area 
of each land cover type using Calculate Geometry (see Appendix A-11) and 
save as Area_ha 

2. Identify the dominant land cover type with the largest total area within the AA 
3. Divide the area of the dominant land cover type by the total AA land cover area 
4. Calculate proportions and enter the result as a decimal with a maximum value 

of 1 

OF 36: Number of land cover types in the AA and 100 m buffer 
Relevant layers and datasets:  

o B.C. Land Cover (if available) 
o VRI attribute bclcs_level_4 
o Sentinel Land Cover  

  
“The number of different land cover types mapped within the AA, plus all land cover 
types within 100 m of its edge is:” 

Notes:  
• Use the land cover classification to identify unique land cover types present within 

the AA and its 100 m buffer. Each unique class counts once, regardless of area 
• In cases where available land cover mapping is inaccurate, defer to observed land 

cover types based on the most recent available imagery 

Select one of the following: 
o 1 
o 2 
o 3 or 4 
o >4 

 
1. Consider the Buffer_100m_including_AA layer 
2. Clip the land cover layer to the Buffer_100m_including_AA layer (see Appendix 

A-13) and save as Landcover_AA_100m 
3. Identify unique classes by using the Attribute Table and reviewing the 

Classification field 
i. If unclear, run Summary Statistics (see Appendix A -13) 

4. Count the number of unique land cover types present and select the 
appropriate category 

OF 37: Number of land cover types within 2 km 
Relevant layers and datasets:  

o B.C. Land Cover (if available) 

https://catalogue.data.gov.bc.ca/dataset/vri-2024-forest-vegetation-composite-rank-1-layer-r1-
https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer


W E SP - B C  D e sk t o p Asse ssme nt   |   B C  W i l d l i f e  F e de ra t i o n    

Version 1.0 beta 31 June 16, 2026 

o VRI attribute bclcs_level_4 
o Sentinel Land Cover   
o Aerial imagery 

 
“The number of different land cover types mapped within the AA plus all types 
within the 2 km buffer is:” 

 
Notes:  

• Use the land cover classification to identify distinct types present within the AA and 
its 2 km buffer. Each unique class counts once, regardless of area 

• In cases where available land cover mapping is inaccurate, defer to observed land 
cover types based on the most recent available imagery 

Select one of the following: 
o <4 
o 4 or 5 
o 6 or 7 
o 8 to 11 
o >11 

 
1. Clip the land cover layer to the Buffer_2km_including_AA layer (see Appendix 

A-13) and save as Landcover_AA_2km 
2. Identify unique classes by using the Attribute Table and reviewing the 

Classification field 
3. If unclear, run Summary Statistics (see Appendix A -13)  
4. Count the number of unique land cover types present and select the 

appropriate category 
 

OF 38: Deciduous land cover within the AA and 100 m buffer 
Relevant layers:  

o VRI attribute bclcs_level_4 

“The percentage of the deciduous land cover type within the AA plus 100 m from its 
edge, as compiled from the land cover layer, is:” 
 
Notes:  

• In cases where available land cover mapping is inaccurate, defer to observed land 
cover types based on the most recent available imagery 

Select one of the following: 

https://catalogue.data.gov.bc.ca/dataset/vri-2024-forest-vegetation-composite-rank-1-layer-r1-
https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
https://catalogue.data.gov.bc.ca/dataset/vri-2024-forest-vegetation-composite-rank-1-layer-r1-
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o <6% 
o 6-20% 
o 21-39% 
o 40-66% 
o >66% 

 
1. Clip the VRI to a 100m buffer from the edge AA 
2. Open the Attribute Table and consider the attribute bclcs_level_4, which 

indicates the type of vegetation 
i. Under bclcs_level_4 values of “TB” (tree-broadleaf) should be considered for 

this question 
3. Calculate areas using the Calculate Geometry (see Appendix-10) to find the 

area of deciduous polygons (ha) 
4. Use the formula below to calculate the percentage of deciduous land cover 

within the AA and 100 m buffer: 

Deciduous % =  
Total Deciduous Area

Total AA + 100m Buffer Area
 X 100 

 

OF 39: Closed coniferous land cover within the AA and 100 m buffer 
Relevant layer:  

o VRI attribute bclcs_level_4 

“The proportion of the coniferous land cover type within the AA plus 100 m from its 
edge, as compiled from the land cover layer, is:” 
 
Notes:  

• In cases where available land cover mapping is inaccurate, defer to observed land 
cover types based on the most recent available imagery 

Select one of the following: 
o <20% 
o 20-47% 
o 48-69% 
o 70-90% 
o >90% 

 
1. Clip the VRI to a 100m buffer from the AA 
2. Open the Attribute Table and consider the attribute bclcs_level_4, which 

indicates the type of vegetation 

https://catalogue.data.gov.bc.ca/dataset/vri-2024-forest-vegetation-composite-rank-1-layer-r1-
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i. Under bclcs_level_4 values of “TC” (tree-coniferous) should be considered 
for this question 

3. Calculate areas using the Calculate Geometry (see Appendix-10) to find the 
area of coniferous polygons (ha) 

4. Use the formula below to calculate the percentage of coniferous land cover 
within the AA and 100 m buffer: 

Coniferous % =  
Total Coniferous Area

Total AA + 100m Buffer Area
 X 100 

 

OF 40: Non-tree vegetation within the AA and 100 m buffer 
Relevant layer:  

o VRI attribute bclcs_level_4  
 
“The percentage of the land cover that is non-tree, within the AA plus 100 m from its 
edge, as compiled from the land cover layer, is:” 
 
Notes:  

• In cases where available land cover mapping is inaccurate, defer to observed land 
cover types based on the most recent available imagery 

Select one of the following: 
o <10% 
o 10-25% 
o 25-45% 
o 45-75% 
o >75% 

 
1. Clip the VRI to a 100m buffer from the AA 
2. Open the Attribute Table and consider the attribute bclcs_level_4, which 

indicates the type of vegetation 
i. Under bclcs_level_4 consider all values except the TC (tree-coniferous), TB 

(tree-broadleaf), and TM (Tree-Mix) for this question 
3. Calculate areas using the Calculate Geometry (see Appendix-10) to find the 

area of non-treed polygons (ha) 
4. Use the formula below to calculate the percentage of non-treed land cover  

within the AA and 100 m buffer: 

 Non − treed =  (Total AA+100m Buffer Area) − Sum of TC,TB,TM Areas
Total AA+100m Buffer Area

 X 100 
 

  

https://catalogue.data.gov.bc.ca/dataset/vri-2024-forest-vegetation-composite-rank-1-layer-r1-
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OF 41: Disturbed area percentage in the WAU 
Relevant layer:  

o Assessment Watershed Unit (WAU) 
o B.C. Cumulative Effects Framework – Human Disturbance  

 
“As a percentage of the WAU, the Disturbed area (GIS layer provided) comprises:” 
 
Notes:  

• This measure reflects disturbance proportion across the full WAU, not just within the 
AA 

Select one of the following: 
o <10% 
o 10-20% 
o 20-30% 
o 30-40% 
o >40% 

 
1. Consider the WAU layer, and document it’s total area in hectares 
2. Clip the Human Disturbance layer to the WAU boundary and save as 

“Disturbed_WAU” 
3. Open the Attribute Table of Disturbed-WAU and select all disturbed areas 

i. Disturbance is typically coded as 1 = Not disturbed and 2 = Disturbed. 
ii. Filter for “Disturbed (2)” values only 

4. Use Calculate Geometry to measure the disturbed area in hectares and sum 
these values to determine the total disturbed area (see Appendix A-11,or 13. 

5. Use the formula below: 

Disturbed % (WAU) =  
Total Disturbed Area

Total WAU Area
 X 100 

 

OF 42: Road density in the WAU 
Relevant Layers and Datasets:  

o Watershed Assessment Unit (WAU) 
o Cumulative Effects Framework – Integrated Roads – 2025 
o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 

 
“Intersect the WAU with the Digital Road Atlas. The length (km) of all roads within 
that WAU, divided by the WAU's area, is:” 

https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
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Notes: 
• Include all road types present in the Integrated Roads layer (paved, unpaved, and 

resource roads) 
• Make sure road length is in km 
• The WAU area should be measured in km2, not ha. This will result in road density in 

units of km/km2 

Select one of the following: 
o <0.4 km/km2 
o 0.4-1.2 km/km2 
o > 1.2 km/km2  

 
1. Consider the WAU layer 
2. Clip the roads layer to the WAU boundary and save as Roads_WAU 
3. Open the Attribute Table to calculate the total road length  

i. Sum the total road length in km (see Appendix A:13) 
4. Calculate road density: 

i. Confirm the WAU area in km2 (Appendix A:10) 
ii. Use the following formula: 

Road Density =  
Total Road Length (km)

WAU Area (km2)
 

iii. Choose the appropriate category 
 

OF 43: Wetland density in the WAU 
Relevant Layers and Datasets:  

o Watershed Assessment Unit (WAU) 
o Freshwater Atlas – Wetlands 
o Any additional local wetland mapping (if available) 

 
“The summed area of all wetlands in the wetland's WAU, divided by the WAU's area, 
is:” 

Select one of the following: 
o <0.03 
o 0.03-0.04 
o 0.05-0.07 
o 0.08-0.13 
o >0.13 

 
1. Consider the Wetlands layer 

https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
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2. Clip the wetlands layer to the WAU boundary and save as Wetlands_WAU 
3. Open the Attribute Table to calculate the total wetland area in km2  

i. Sum the total wetland area in km2 (see Appendix A:13) 
4. Calculate wetland density: 

i. Calculate the WAU area in km2 (Appendix A:10) 
ii. Use the following formula: 

Wetland Density =  
Wetland area (km2 )

WAU Area (km2)  

iii. Choose the appropriate category 
 

OF 44: Ecoprovince 
Relevant layer: 

o Ecoprovinces - Ecoregion Ecosystem Classification of British Columbia 
 

“The AA's ecoprovince is:” 

NOTES: 
• If the AA falls within more than one ecoprovince, visually estimate which ecoprovince 

covers the majority of the AA. 

Select one of the following: 
o Boreal Plains (BP) 
o Central Interior (CI) 
o Coast and Mountains (CM) 
o Georgia Depression (GD) 
o Northern Boreal Mountains (NBM) 
o Southern Interior (SI) 
o Southern Interior Mountains (SIM) 
o Sub-Boreal Interior (SBI) 
o Taiga Plains (TP) 

 
1. Identify the AA’s ecoprovince using Select Layer by Location 

i. Choose ecoprovinces as the input feature, AA as the selecting feature, and 
ensure relationship is set to intersect 

2. Determine ecoprovince classification: 
i. Open the Attribute Table of the selected ecoprovince polygon and locate 

the ecoprovince name 
3. Select the matching option from the list above  

https://catalogue.data.gov.bc.ca/dataset/51832f47-efdf-4956-837a-45fc2c9032dd
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APPENDIX A - Common GIS tools 

1. Creating a buffer 
Buffers are used to define an area within a specified distance around features: 
 

1. Open the Buffer Tool (Go to Analysis > Tools > Buffer) 
2. Set Input Features:  

i. Choose the feature layer you want to buffer (for example, CA_Polygon, 
AA_of_Interest) 

3. Specify Buffer distance: 
i. Enter the distance (for example, 100 meters) 

ii. Choose the correct unit (meters, kilometers, etc.) 
4. Save output with the appropriate file name 
5. Select Run 

 
Tip: Adjust layer transparency (see Appendix A:2) for instructions on how to overlap the 
buffer with other layers. 
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2.  Optimizing layer transparency 
Transparency allows you to see multiple layers at once by making one layer partially 
see-through. This is useful when comparing overlapping datasets: 

 
1. Select the layer of interest in the Contents Pane 
2. Open the Appearance tab (Go to the Feature Layer > Appearance on the ribbon) 
3. Adjust Transparency: 

i. Use the Transparency slider to set the desired level (for example, 70%) 
4. Arrange order of layers in the Contents Pane to ensure your transparent layer 

is above the reference layers 
 

 
 

  



W E SP - B C  D e sk t o p Asse ssme nt   |   B C  W i l d l i f e  F e de ra t i o n    

Version 1.0 beta 43 June 16, 2026 

3. Adding datasets to map  
1. Go to the Map tab > select Add Data > browse to your data source (for 

example, saved local file on C drive). 
2. Select the desired dataset > select Add 
3. The layer is added to your map and appears in the Contents pane 

4. Accessing spatial data using WESPR package 
The WESPR GitHub includes instructions on how to prepare spatial data and use a 
package that obtains the majority of the datasets from the BC data package. This 
package shows if there are no layers within your relevant search area, and eases the 
burden of viewing each dataset separately.  

5. Exporting data from iMapBC 
1. Go to IMAPBC 
2. Use Add Provincial Layers in the Data Sources tab to find and check off the 

layers you need 
3. Select the Export tab 
4. Select Provincial Layer Download 
5. In the download service panel, select the layers you want (toggle on oroff), 

choose area of interest (extent), select output format (for example Shapefile 
preferred) and coordinate system 

6. Enter your email if required, agree to terms, then Submit Order 
7. Wait for a link with the download; unzip/import into ArcGIS Pro 

6. Using the BC Data Catalogue 
1. Go to BC Data Catalogue  
2. Search for the dataset name or topic (for example, Freshwater Atlas Wetlands) 
3. Use filters like Format = Shapefile or geodata to narrow results 
4. Download the data and unzip if needed 
5. In ArcGIS Pro, go to Map > Add Data > browse to the extracted shapefile or 

layer package 

7. Adding basemaps 
Basemaps provide background context for your data. ArcGIS Pro includes built-in 
basemaps such as Topographic, Imagery, Streets and more: 

1. Open the Basemap gallery and select Basemap 
2. From the gallery, choose the desired basemap (for example, Topographic, 

Imagery, Streets) 

https://bcwf-wetlands.github.io/wespr/articles/prepare_spatial_data.html
https://catalogue.data.gov.bc.ca/datasets
https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
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3. To manage visibility, you can toggle the basemap on or off in the Contents 
Pane  

8. Measure distances 
The Measure tool allows you to calculate distances directly on the map. This is useful 
for estimating travel paths or validating buffer distances 

1. Go to Map and select the Measure tool: . 
2. Choose measurement type by selecting the Distance option 
3. If needed, set the desired units (for example, meters, kilometers) from the 

drop-down list 
4. Measure distance: 

i. Select once on the map to set the starting point 
ii. Select again to set the end point 
iii. The distance is displayed in the Measure window 

5. To finish the measurement, double-select to the end of the measurement 

9. Intersect features 
The Intersect tool combines two or more layers and keeps only the areas where they 
overlap. This tool preserves the attributes from all layers in the output. This is useful 
when you need to find features that share the same space (for example, wetlands 
within a buffer, roads crossing a watershed). Note, this feature will find all combinations 
of overlap (for example, 1, 2, and 3; 2 and 3 but not 1, 1 and 2 but not 3) 

1. Open the Intersect tool (Go to Analysis > Tools > Intersect) 
2. To set the Input Features, select two or more layers you want to intersect (for 

example, Wetlands_2km and Buffer_2km) 
3. In the tool options, set the desired output type (for example, Point, Line, 

Polygon) 
4. Save the results with a clear name (for example, Clipped_Wetlands_2km) 
5. Select Run 

10. Merge layers tool 
To combine two feature layers of the same geometry (e.g,. points, lines, polygons), use 
the Merge Layers Tool: 

1. Open the Merge Layers Tool (Analysis>Manage Data>Merge Layers) 

2. To set the Input Features, select two layers you want to merge 
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3. Save the results with a clear name (for example, Lakes and Wetlands in 2km) 

4. Select Run 

11. Calculate geometry  
The Calculate Geometry function allows you to populate a field with geometric 
properties of features, such as area, length, or coordinates. This is useful for 
reporting quantitative results (for example, hectares of wetlands, length of 
streams). 

1. Right-select the layer of interest in the Contents Pane and select 
Attribute Table. 

2. If needed, add a new field by selecting Add Field 
i. Name the field clearly (for example, Area_ha, Length_km). 

ii. Set Data Type = Double to store decimal values 
iii. Select save to add the field data 

3. Open the Calculate Geometry by selecting the new field heading. 
4. Choose the desired geometry property (for example, Area, Length, X/Y 

Coordinates). 
5. Select Run 

12. Erase features 
The Erase tool removes portions of one layer that overlap another layer. The output 
contains only the parts of the input features that do not overlap the erase features. 
This is useful when you want to exclude areas (for example, subtracting wetlands 
from a contributing area): 

1. Open the Erase tool (Go to Analysis > Tools > Erase) 
2. To set Input Features, choose the layer 

that you want to modify (for example, 
Catchment Area, CA) 

3. Choose the layer that will be removed 
from the input (for example, AA_polygon) 

4. Save the results with a clear name (for 
example, CA_excluding_AA) 

5. Select Run 
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13. Clip features 
The Clip tool trims features to the boundary of another layer. The output contains only 
the portions of the input features that fall inside the clip features. This tool preserves 
only the attributes from the clipped layer. This is useful for restricting data to an area 
of interest (for example, clipping streams to a watershed): 
 

1. Open the Clip Tool (Go to Analysis > Tools > Clip) 
2. To set Input Features, select the layer you want to trim 
3. To set Clip Features, choose the boundary layer thar defines the area of 

interest (for example, AA_boundary) 
4. Save the results with a clear name (for example, 

Streams_within_watershed). 
5. Select Run 

14. Summary statistics 
The Summary Statistics tool calculates totals, averages, and other statistics for one 
or more fields in a dataset, grouped by an attribute (for example, land cover type): 

1. Open the tool and search for Summary Statistics. 
2. Set inputs: 

i. Input Table = the dataset you want to summarize (for example, 
AA_Landcover) 

ii. Output Table = choose a name and save location (for example, 
AA_Landcover_Summary) 

3. Choose fields and statistics: 
i. Under Statistics Fields, select the numeric field you want to 

summarize (for example, Area_ha) 
ii. Choose a statistic type (for example, Sum, Mean, Minimum, 

Maximum) 
iii. You can add multiple fields or multiple statistics if needed. 

4. If you want results broken down by category (for example, land cover 
type), add the relevant field under Case Field 
i. If no Case Field is set, results will be calculated for the entire table 
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